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Overview

This document describes the database views that you can use to run reports in HPE Cloud Service Automation (CSA). Included is a
database view that allows you to run a report showing contents of the CSA audit log. This document also provides an example of how
to install, configure, and use third-party reporting software (from Jaspersoft Corporation) to run CSA reports.

Prerequisites

CSA supports databases from Oracle, Microsoft SQL, and PostgreSQL for reports. Before you can run reports, you must create a read-
only database user (and a role, if using Oracle) specifically for reporting purposes, and then you must specify its username and
password during the CSA installation or upgrade. If you did not add this user during installation or upgrade, see the Cloud Service
Automation Configuration Guide for instructions on how to add this user.

Database Views for Standard Reports

CSA provides some commonly-needed information for a sequence-based model through the (non-materialized) database views for
reporting. A read-only database user will have access to these views, which they can use to design reports.

Note: For audit reports, see the Database View for Audit Reports section.

The following table lists each view and some filters (list of values) that read-only users can use in a report designer.

Table 1. List of Database Views

Number View name

RPT_RSC_CAPACITY_V

RPT_USER_SUBSCRIPTION
\%

RPT_SUBSCR_RSC_V

RPT_SUBSCR_OPTS_V

RPT_RESOURCE_UTILIZATI
ON_V

RPT_PAY_PER_USE_METE
RV

RPT_LICENSE_OSI_USAGE
Y%

Filters (list of values)

RPT_LOV_PROVIDER_V
RPT_LOV_PROV_POOL_V

RPT_LOV_ORG_V
RPT_LOV_ORG_USR_V
RPT_LOV_CAT_OFFR_V

RPT_LOV_PROVIDER_V
RPT_LOV_PROV_POOL_V

RPT_LOV_ORG_USR_V
RPT_LOV_PROVIDER_V

RPT_LOV_PROV_POOL_V
N/A

N/A

Description and comments

Within each Pool, list Resource Type, Quantity
Used, Quantity Remaining, and Units.

Group by Organization and by User consuming
the subscription (filter by organization, user, and
offering). Group information must be fetched
from the view. The group here is the ‘Owned By’

group.

Group by Provider and by the Resource Pools
defined within it (with subscription details).

Show the options and option prices for
subscriptions.

Provide information on resource utilization for
subscriptions.

List the maximum operating system instances
(OSI) being used in CSA active subscription for
each organization in the last 30 days.

List the total OSI being using in CSA active
subscription for the CSA instance.

RPT_RSC_CAPACITY_V View

This view provides a list of providers and pools and their available capacity and utilization.

Table 2. RPT_RSC_CAPACITY_V View
Field name (in the view)
PROVIDER_ID
PROVIDER_NAME
PROVIDER_TYPE

Functional description
Identifier of the resource provider.
Name of the resource provider.

Type of resource provider.
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SERVICE_ACCESS_POINT
RESOURCE_POOL_ID
RESOURCE_POOL_NAME
KNOWN_TO_PROVIDER_AS
RESOURCE_TYPE
AVAILABILITY
AVAILABLE_TO_CSA
USED_BY_CSA

RPT_USER_SUBSCR_V View

Access point URL for the provider.

Identifier of the resource pool.

Name for the resource pool.

Name of the resource pool used by the provider.

Type of resource (such as CPU or Storage).

Category to indicate if the resource is available.

Quantity of the resource that is available to CSA in the pool.

Quantity of the resource that has been used by CSA from this pool.

This view provides detailed information for subscriptions (excluding the Option selection and Pricing information).

Table 3. RPT_USER_SUBSCR_V View

Field name (in the view)
SUBSCRIPTION_ID
SUBSCRIPTION_NAME
SUBSCRIPTION_START_DATE
SUBSCRIPTION_END_DATE
SUBSCRIPTION_OWNER_GROUP

SUBSCRIPTION_STATUS
REQUESTED_BY_USER_ID
REQUESTED BY_USER
REQUESTED BY_USER_EMAIL
ORGANIZATION_ID
ORGANIZATION_NAME
CATALOG_ID

CATALOG_NAME
SERVICE_OFFERING_ID
SERVICE_OFFERING_NAME

RPT_SUBSCR_RSC_V View

Functional description

Identifier of the subscription.

Name of the subscription as displayed.
Start date of the subscription.

End date of the subscription.

Name of the group that owns this subscription (applicable only for subscriptions
owned by a group).

Status of the subscription.

Identifier of the user requesting the subscription.

Name of the user requesting the subscription.

Email address of the user requesting the subscription.

Identifier of the organization to which this subscription belongs.

Name of the organization to which this subscription belongs.

Identifier of the catalog to which this subscription belongs.

Name of the catalog to which this subscription is published.

Identifier of the service offering for which this subscription was submitted.

Name of the service offering for which this subscription was submitted.

This view provides information about the Resource Provider and Resource Pool used by a subscription.

Table 4. RPT_SUBSCR_RSC_V View
Field name (in the view)
SUBSCRIPTION_ID
RESOURCE_PROVIDER_ID
RESOURCE_PROVIDER_NAME
PROVIDER_ACCESS_POINT_URI
RESOURCE_RPOVIDER_TYPE

Cloud Service Automation
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Functional description

Identifier of the subscription.

Identifier of the resource provider.

Name of the resource provider.

Access point URI of the resource provider.

Type of the resource provider.
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RESOURCE_POOL_ID
RESOURCE_POOL_NAME

RPT_SUBSCR_OPTS_V View

Identifier of the resource pool.

Name of the resource pool.

This view provides the options and option prices for subscriptions.

Table 5. RPT_SUBSCR_OPTS_V View

Field name (in the view)
SUBSCRIPTION_ID
OPTION_MODEL_ID
CURRENCY_DISPLAY_NAME

RECURRING_PERIOD_DISPLAY_NAME

L1_OPTION_SET_ID
L1_OPTION_SET_NAME
L1_OPTION_SET DISPLAY_NAME
L1_OPTION_ID
L1_OPTION_NAME
L1_OPTION_DISPLAY_NAME
L1_OPTION_SELECTED

L1_INITIAL_PRICE
L1_RECURRING_PRICE
L2_OPTION_SET_ID
L2_OPTION_SET_NAME
L2_OPTION_SET_DISPLAY_NAME
L2_OPTION_ID
L2_OPTION_NAME
L2_OPTION_DISPLAY_NAME

L2_OPTION_SELECTED

L2_INITIAL_PRICE
L2_RECURRING_PRICE
L3_OPTION_SET_ID
L3_OPTION_SET_NAME
L3_OPTION_SET_DISPLAY_NAME
L3_OPTION_ID
L3_OPTION_NAME
L3_OPTION_DISPLAY_NAME
L3_OPTION_SELECTED

L3_INITIAL_PRICE

Cloud Service Automation
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Functional description

Identifier of the service subscription.

Identifier of the option model.

Display name of the currency used in the option model.
Display name of the recurring period used in the option model.
Top-level option set ID.

Top-level option set name.

Top-level option set display name.

Top-level option ID.

Top-level option name.

Top-level option display name.

'Y" if the top-level option is selected.
‘N if the top-level option is not selected.

Initial price of the top-level option.
Recurring price of the top-level option.
Child-level option set ID.

Child-level option set name.
Child-level option set display name.
Child-level option ID.

Child-level option name.

Child-level option display name.

"Y' if the child-level option is selected.
‘N if the child-level option is not selected.

Initial price of the child-level option.
Recurring price of the child-level option.
Grandchild-level option set ID.
Grandchild-level option set name.
Grandchild-level option set display name.
Grandchild-level option ID.
Grandchild-level option name.
Grandchild-level option display name.

'Y" if the grandchild-level option is selected.
‘N' if the grandchild-level option is NOT selected.

Initial price of the grandchild-level option.
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Field name (in the view) Functional description

L3 RECURRING_PRICE Recurring price of the grandchild-level option.

RPT_ROESOURCE_UTILIZATION_V View

This view provides the information on resource utilization for subscriptions.

Table 6. RPT_RESOURCE_UTILIZATION_V View

Field name (in the view) Functional description

SUBSCRIPTION_ID Identifier of the subscription.

SUBSCRIPTION_NAME Name of the subscription.

COMPONENT_ID Identifier for the service component.

COMPONENT_NAME Name of the service component.

RESOURCE_POOL_ID Identifier of the resource pool.

RESOURCE_POOL_NAME Name of the resource pool.

PROVIDER_ID Identifier of the provider.

PROVIDER_NAME Name of the provider.
MEASURABLE_PROPERTY_NAME Name given to the measurable property.
RESOURCE_TYPE Type of resource for this measurable property.
RESOURCE_UNIT Measuring unit of this resource in the measurable property.
UTILIZATION Quantity of this resource that has been used by this subscription in this pool.

RPT_PAY_PER USE_METER_V

This view provides a list of the maximum operating system instances (OSI) being used in CSA active subscriptions for each
organization in the last 30 days.

Table 7. RPT_PAY_PER_USE_METER_V View

Field name (in the view) Functional description

START_DATE Start date from which the OSI usage is determined. By default, this
is 30 days prior to the current date.

END_DATE End date to which the OSI usage is determined. By default, this is the
current date.

ORGANIZATION Name of the organization to which the OSI usage belongs.

DEPLOYED_OSI_COUNT OSI count consumed by the organization.

MAXIMUM_OSI_LIMIT Cumulative count of purchased OSI.

RPT_LICENSE_OSI_USAGE_V

This view provides a list of the total operating system instances (OSl) being used in CSA active subscriptions for the CSA instance.

Table 8. RPT_LICENSE_OSI_USAGE_V View
Field name (in the view) Functional description

START_DATE Start date from which the OSI usage is determined. By default, this is
30 days prior to the current date.

Cloud Service Automation Page 6
Reporting and Auditing



END_DATE End date to which the OSI usage is determined. By default, this is the
current date.

DEPLOYED_OSI_COUNT OSI count consumed by the organization.
MAXIMUM_OSI_LIMIT Cumulative count of purchased OSI.

Database View for Audit Reports

CSA provides auditing capability by creating an audit event record in the CSA database for several important events that occur during
the lifetime of a running instance of CSA. Each audit event has a Classification Code and Operation Type attribute, as indicated below.
CSA captures audit log information for the following events:

e User Authentication to CSA and the Marketplace Portal
- For every successful login and unsuccessful login attempt, an audit event record is created.
- Classification Code - Authentication
- Operation Type - Login
e  User Authorization
- If an unauthorized user access is identified, an audit event record is created.
- Classification Code - Authorization

- Operation Type - Access

e CSA Service Start and Stop

An audit event record is created every time the CSA service is started and stopped.
Classification Code — Server Management

Operation Type — Server Start, Server Stop

e Transactional Events Involving CSA Artifacts

Whenever a CSA artifact is created, updated or deleted, an audit event record is created. CSA artifacts include Service Design,
Service Offering, Organization, Catalog, Service Request, Subscription, Approval Process, and Service Instance.

Classification Code — ‘Create Update Delete’

Operation Type — Create, Update, Delete

e Change in Service Offering Price

An audit event record is created when pricing for a service offering changes.
Classification Code — ‘Create Update Delete’

Operation Type — Create, Update, Delete

e Transactional events involving the LDAP access point

Whenever the LDAP access point of an organization is created or updated, an audit event record is created.
Classification Code — ACCESSPOINT

Operation Type — Create, Update

Cloud Service Automation Page 7
Reporting and Auditing



The audit information can be accessed using the following database view:

e RPT_AUDIT_EVENT_V

Like the other CSA reporting views, a read-only database user will have access to this view, which they can use to design audit reports

in a report designer.

Note: See the Audit Report Examples section for example queries for audit reports.

Note: Audit event data can be purged if desired by running the Database Purge tool. See the Cloud Service Automation Configuration

Guide for more information.

RPT_AUDIT_EVENT _V View

This view provides information from the CSA audit log.

Table 9. RPT_AUDIT_EVENT_V View
Field name (in the view)
CREATED_ON
MODIFIED_BY_USERNAME

USER_ORGANIZATION_NAME
ARTIFACT_ID
ARTIFACT_NAME

ARTIFACT_TYPE
AUDIT_CLASSIFICATION
AUDIT_OPERATION
ORIGINATING_SERVER

SERVER_TYPE
DESCRIPTION
AUTHENTICATION_USER

ORIGIN_IP

Cloud Service Automation
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Functional description
Timestamp when the audit event was created.

User name of the user who accessed the CSA system at login and created,
modified or deleted the CSA artifacts or created or modified the LDAP access
point.

Organization to which the user accessing the CSA system belongs.
Unique ID of the artifact being created, updated, or deleted.

Name of the artifact at the time the audit event was generated. In case of an
LDAP access point transaction, this is the organization to which the user
accessing the CSA system belongs.

Type of artifact being created, updated, or deleted.

Audit Classification Code. See Database View for Audit Reports for possible
values and how they are used.

Audit Operation Type. See Database View for Audit Reports for possible values
and how they are used.

Server name from where the logon attempt was made. This attribute is currently
used only for the authentication event.

Currently used only for authentication event and set to ‘IDM.’
Description of the audit event.

The user used for basic authentication of a REST call. For Legacy CSA 3.x API
calls, this is the user used for HTTP basic authentication of a REST call. For
Consumer (Consumption) API calls, this is the user for which the X-Auth-Token
HTTP header has been provided (the name of the HTTP header may be
different if you customized the xAuthToken configuration property in
csa.properties; see the Cloud Service Automation Configuration Guide for
more information about this property). For Management (Consumption) API
calls, this information is not captured (this field is empty).

The IP address from which a Legacy CSA 3.x or Consumer (Consumption) API
call originates. Only Consumer APIs that include the onBehalf parameter in the
Response Content Type capture the IP address. For the remaining Consumer
APIs, this information is not captured (this field is empty). For Management
(Consumption) API calls, this information is not captured (this field is empty).

If the csa.origin.ip.header property is configured in the csa.properties
configuration file, CSA captures the originating IP address from the custom
HTTP header defined by the property.
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If the csa.origin.ip.header property is not configured, CSA uses the X-

Forwarded-For HTTP header as the originating IP address.

If the csa.origin.ip.header property is not configured and the X-Forwarded-For

HTTP header is not set, CSA fetches the originating IP address from the

incoming request.

For more information about the csa.origin.ip.header property, refer to the

Cloud Service Automation Configuration Guide.

Use Jaspersoft Software to Create and Deploy Reports

This section uses Jaspersoft software as an example of how to install, configure, and use third-party reporting tools to create and

deploy CSA reports.

Install Jaspersoft iReport Designer and Create Reports

iReport Designer is the report development tool for JasperReports and JasperReports Server.

1. Install iReport Designer by following the instructions at:

http://sourceforge.net/projects/ireport/
2. Start iReport Designer.

The New file dialog box appears.

mrﬂew file

Report

Style

|
t) Chart Theme

Resource Bundle

w
ﬁﬁ Other file Types

& report is used to display values from a data source like a databasze or an XML file,
Select a starting point for your report or choose the wizard to guide you.

* (‘nl“.’u_‘l’nk ﬂ
* Cullix Titk:
Coffee Coffee Landscape
@
N =
@ i
“Flower
i |
Open this Template Launch Report Wizard | Cancel |

3. Click to select a report template.

4. Click Open this Template.

The Name and location dialog box appears.

Cloud Service Automation
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http://sourceforge.net/projects/ireport/

MNEW

Steps Mame and location

1. Choose Template
2.  Mame and location
3. Finish

Report name; ISubscriptiDnByPrDvider

Location: IC:'I,Llsers'l,.ﬁ.dministratu:ur'l,Desktnp Browse |

File: Il,Llsers'l,.ﬁ.u:lministratu:ur'l,Deskl:-:up'l,SuI:uscriptiu:unB';.fF‘rn:wiu:Ier.jrxml

< Back | Mexk = I Eimish Cancel Help

5. Enter the report name into the Report name field.

The default location in the Location field is your desktop. You can click the Browse button to select another location to store the
template. The .jrxml file is always saved to the same folder as the template.

6. Click Next.
The Query dialog box appears.

Cloud Service Automation Page 10
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Steps Query

Zhoose Template
Mame and location

1

2

3. Query

4, Fields Ernpty datasource =
2

&

Canneckions | Daka Sources

Group by,
Finish

< Back | Mext = I Finish Cancel Helm

7. Do one of the following.
e Select an existing data source from the Connections / Data Sources pull-down menu.
e Click New to create a new connection/data source, if no connections/data sources are available.

If you clicked New, the Datasource dialog box appears.

Cloud Service Automation Page 11
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“sa=" Datasource

Select the datasource bype

Diatabase IO i y
MetBeans Database JDBC connection
%ML file datasource

JavaBeans set datasource

File C5% datasource
JRDataSourceProvider

Zuskam JRDataSource

Empty data source

Hibernate connection

Spring loaded Hibernate conneckion
EJBOQL conneckion

AMLA Server

Mondrian OLAP conneckion

Cuery Executer mode

Microsoft Excel (xls) data source
Microsoft Excel 2007 (xlsx) data source
MongoDE Conneckion

Femote =ML file datasource

150N datasource

Hadoop Hive Connection

Sample Database Connection

Tiesk || Mext = I Zancel

8. Select the Database JDBC connection data source type.
9. Click Next.

The Database JDBC connection dialog box appears.

Cloud Service Automation
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"y
[ x|

e —
\n.—..-c!
“sas" Database JDBC connection
Marne I
IDBC Driver I PostgresQL (org.postgresgl.Driver) LI

IDEC URL del:uc:pu:ustgresql:,l',l'Iu:u:th-:ust:5432,I'DatabaseName

- Credentials

Usernarme I

Passwiord I

[T Save passward

ATTEMTION! Passwaords are stored in clear text, IF you donk specify a
v, password now, iReport will ask you for one only when required and will not
sawve ik,

Test | Save I Cancel

10. Fill in the following dialog box fields:
e Name
e JDBC Driver
Select the correct driver for your database.
e JDBCURL
e Username
e Password

If the driver for your database is not available, it appears in red, which means that it is not in the classpath.

Cloud Service Automation Page 13
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-
| —
" Dpatabase JDBC connection
Mame |CSf_test

o

JDEC Driver | PostgresgL {Drg.pustgresql.Driver}| LI

M3 S0LServer (netsourceforge, jids, jdbe, Driver) -
M3 S0LServer (com.merant,datadirect, jdbe, sqlserver, SOLSerwerDFv

~Credentialg™y'SL (org.git.rmm. ryesgl. Driver)
MySOL (oam. mysqgl, jdbe, Driver)

JDEC URL

Lsername [

[ =¥ 3
P ostaresL I{Drg.pastgres Driver class oracle, jdbe, drivar, QracleDriver
Sybase (com.sybase JdbC2) Lo Faund in the classpathl

Wertica (com,verkica, Driver -

ATTEMTION! Passwaords are stored in clear text, IF wou dont specify a
', password now, iReport will ask wou For one only when reguired and will not
save it,

Tesk | Save I Cancel

11. If the driver is not available, select Tools > Options > Classpath > Add JAR from the menu bar.

12. Add the driver to the classpath as in the following dialog box.

Cloud Service Automation Page 14
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% B a

Editor Fonts & Colors

R

iRepork General

Export ootions | JasperReports Properties

Miscellaneous

Keymap

I Heartheat |

JasperReports Server Repository

General Classpath I Fonts Wigwers ‘Wizard Templates | Zompilation and execution Query Execukers
Classpath
Path Relnadable Add JaR
Cs\Program Files (x86))JaspersoftiiReport-3.5. Dlireportimodules extihsgldb-1.5. . [}
Zs\Program Files (x56))JaspersoftiiReport-3.5. Dlireportimodules ext jasperrepor., [} Add Folder |
Cs\Program Files (x86))JaspersoftiiReport-3.5. Dlireportimodules) ext jasperrepor., [}
Remove |
dd JAR / path to the cl th =
(s} / path to the classpal X] Mave up |
Look in: I b LI B i i

TMove down |

. reportRead?. html_files

=] cherry.ipg

=] coffee.jpg

W] coffee_stain.png

ojdbcS.jar

ojdbcS_g.jar

ojdbcSdms. jar
ojdbcSdms_g.jar

EEEE

ojdbce_g.jar
ojdbcadms. jar

EEE]E

ojdbcadms_g.jar

|| report_Resource_Capacity . jasper
IE repart_Resource_Capacity jrxml

| 7| reportRead1.html

|| reportReadl. jasper

lﬁ reportRead] . jrxml

|| reportReadl.pdf

|| report-ReadOnly-test. jasper
@ report-ReadOnly-test, jrxml
] simplefan. jar

File name: Injdbce.jar

Cpen I

Files of bype: |n|| Files

Cancel |

E3

Cancel

13. Click Test to validate your username and password with the database.

A popup appears if the test is successful.

Cloud Service Automation
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-

R
)
\'-/ Datahase JDBC conhection

Marme ICS.ﬁ.-Test

JDEC Driver I Cracle {oracle. jdbc. driver . CracleDriver) LI

IDEC URL del:u::Dracle:thin:@lucalhust: 15211234

~Credentials

sernarnne II:SEILISE-'I’

Passwiord I*******

l__' X

ATTEMTIC e fy a
. password Conneckion kest successull d will not
save ik,
Test | Save I Cancel
14. Click OK.
15. Click Save.

The Query dialog box appears.
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Steps Query

1. Choose Template

= et end location Connections | Data Sources

3. Query

4, Fields Icsal LI e
5, Group by...

6, Finish Query (S0L)

select *
from csauser RPT_SUBSCR_RSC_V rsub, csauser RPT_USER _SUBSCRIPTION Y usub
where rsub.subscription_id = usul:u.sul:uscriptinn_id|

Design query | ! Load query | [5] Save query |

< Back | Mext = I Eimish Cancel Helq

16. Click Design query.
17. Use the query editor to design a query and click OK.
Note: See the Audit Report Examples section for example queries for audit reports.
18. Click Next.
The Fields dialog box appears.
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19.
20.

21.

22.

Steps Fields

é EI;?“E:EHT;EE;?DE” IPTIOMN_ID RESOURCE_PROVIDER_MAME
3. Query RESOURCE_PROVIDER _ID PROYIDER &K _POINT_URI
4. Fields RESOURCE_PROVIDER _TYPE

5. Group by, RESOURCE_POOCL_ID

&,  Finish

RESCOURCE_POCL_MAME
SUBSCRIPTION_MAME
SUBSCRIPTION_START_DATE
SUBSCRIPTION_END_DATE
SUBCRIPTION_CWINER_GROUP
SUBSCRIPTION_STATUS
REQUESTED_BY_LISER_ID
REQUESTED_BY_LISER
RECUESTED_BY_UISER_EMAIL
ORGAMIZATION_ID
ORGAMIZATION _MAME -
CATALOG_ID
CATALOG_NAME

< Back Mext =

FEinish

Cancel Helq

Use the arrow buttons to select the fields to appear in the report.

Click Finish.

The template appears in the Designer format.

(Optional) Rearrange the order of the columns (fields) in the report and modify the formatting (such as right- or left-justified) for the

title, field, and column names.

Preview the report by clicking the Preview tab.

Following is a preview of a report.

l#, ProvidersubcriptionReport. jrxml x]

Designer | ML

el (@@ &[n «» n[ (DEMA Ao o] &

Access Point

Subscriptions by Provider

Provider Type Resource Pool

Subscription

Start Date

End Date

https:/Nlocalhost:443 VMware vCenter RnD Pool Windows server subs 2013-11-01 08: null
00:00.0

https:/flocalhost:443 VMware vCenter RnD Pool QA Subscription 2013-11-01 08: null
00:00.0

https:/flocalhost: 443 VMware vCenter RnD Pool Snow White Program 2013-11-01 08: null
00:00.0

http:/itest VMware vCenter  Finance Pool Customer POC #156 2013-11-01 08: null

00:00.0

Cloud Service Automation
Reporting and Auditing

Page 18



Install and Configure JasperReports Server for Use with CSA
1. Install JasperReports Server by following the instructions at:
http://community-static.jaspersoft.com/sites/default/files/docs/jasperreports-server-install-guide. pdf
2. Go to the JasperReports Server login page at:
http://localhost:8082/jasperserver/login.html
3. Enter the following login credentials:

User ID: jasperadmin

Password: jasperadmin

Login

User ID:

jasperadmin

Password:

Show locale & timme zone

Need help logging in?

4. Click View > Repository.

5. Right-click the root/Data Sources folder and select Add Resource > Data Source.
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http://community-static.jaspersoft.com/sites/default/files/docs/jasperreports-server-install-guide.pdf
http://localhost:8082/jasperserver/login.html

e > C [ localhost: 8082/ jasperserver flow html?_flowld=searchFlow

£/ JASPERSOFT  # Library View, Manage,

Il Folders Repository

|§|_; roct

Run Edit Open Copy Cut Pasie Delete
@] Analysis Components -
- . O Marme
[#l Content Files
CSA-R rt

[Crata Sources i
T — Add Folder -server Repository SQL data source
Bl Tripit 5k Tepos Add Resource . Diata Source
Gl Reports Copy Datatype

ol CSA_Report Cut File > urce

[l Interactive Delete Input Control

[Flu Zamples Bormibeiang: lasperReport
[Fl Systern Propert broperis Content Resource
[Hel Themes List of Walues

Expart

Mondrian KMLMA Source
CLAP Client Connection
OLAP Wiew

Query

The Add Data Source dialog box appears.
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&) JASPERSOFT

Add Data Source

#& Library ¥Yiew_, Manage,

Set Data Source Type and Properties

First, select the type of data source you wish to add, then enter the required property values.

Type: |JDBC Data Source =

Mame (required):

Resaurce 1D {required):

Description:

JDBC Driver:

IPostgreSQL {org.postgresql.Driver)

Host {required):

~|  Editoriver..

localhost

Port {required):

5432

Database (required):

dbname

URL {required):

jdbeipostgresql:/flacalhost: 5432/dbname

User Mame (required):

jasperadmin

Password:

Time Zone:

|Use database setting

=

Hint: Do not change the tirne zone setting unless vyou know the database tirmestarnp datz is incorrech,

Save Location (required):

fdatasources

6. Enter information into the following fields:

e Type of data source

Select JDBC Data Source (this is required for the databases supported by CSA).

e Name of your choice

e Resource ID of your choice

e (Optional) Description

e JDBC Driver of the installed database

If the driver is not in the list, you can add the Java archive (JAR) file by using the Edit Driver option.

e Host where the database is installed

Cloud Service Automation
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Enter localhost if the database is on your local system.

Enter the IP address of the system, if your database is installed on another system. (To find the hostname, log in to that

system and enter the hostname command from a command prompt.)
e Port number
e Database name
e URL
Using your hostname and database name, modify the URL as follows:
jdbc:postgresql://<host>:5432/<dbname>
By default, the URL is jdbc:postgresql://localhost:5432/dbname.
e User Name
Enter the same username as for JasperReports Server.
e Password
Enter the same password as for JasperReports Server.

7. Click Save to save the data source.

Deploy a Report in JasperReports Using the iReport Designer
In this procedure, you deploy a report to the server. First, you connect iReport to the repository.

1. Select Window > JasperServer Repository.
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[Mireport 3.5.0
File Edit Formak Wiew Preview | Window Tools  Help

v . ey Farmatting Tools -
% ‘ oo L': : [1] Template Inspeckar J i
| Report Inspectar 3 Repart Inspeckar
:E- reporkl (1l) Repart Problems @ e I.ﬁ.gency FE LIP
1@1 Skyles = ] ?
I%EF‘ararneters o b bo Lt b
@ Fields
ﬁ e A Styles Library
= Scriptlets ¥ =
|_| BacEgru:uunu:I 5= Services Chrl4+5 C Iass IC te m p Iate
""|_| Title ] Favorites Chrl+3
#-[7] Page Header Palette Chrh+Shift+3 SF{TABLE_NAME]
H-[ Column Header )
|_| Detai Welcome to iReport "Page"
""l_l Colum Footer | Properties Chrl+-Shift+7
|—| Page Fooker Cutput k
wo [ Last Page Footer Editar Chrl+0
|_| Surnmary Frocesses
"""" = o Data Close Window CErl4+-
Mazximize Mindow Shift+Escape
Indock Window Ale+shift+0
Zlone Docurment
Close &l Documents CErl-+ShifE+H
Close Other Documents
Documents. ., Shift-+F4
Reset Windows
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The Repository Navigator pane appears.

e Jaspersoft iReport Designer 5.1.0

File Edit ‘ew Format Preview Window Tools Help

[==]
| |

- -_-_I'_- ‘J Il:sal

| Repository Mavigstor

1l =

| & || B

2. Click the —I button to create a new server.

The JasperServer Plugin dialog box appears.
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| Repository Mavigatar 4 x|
J —=tl-:| -"'-_I. |£:.!'

MJaspEﬁerver Plugin

®
S

i o
e
'@" JasperReports Server Access Configuration

@ Prowider
Designer

~Server Information
j{n]

IJasper Server Repository

JasperReports Server LIRL

Ihttp:,l',l'lu:u:alhu:ust:EDSZIjasperserverIservices,l'repu:usitu:ur';.f

—&ccount
Username Passwiord
jaSpEradmin shekckkokekakokkk

Zancel

==

3. Enter values into the following fields for your JasperReports Server:

° ID of the server

You can enter any name of your choice. Enter a name that is meaningful.

e JasperReports Server URL
The default value for JasperReports Server URL is

http://localhost:8080/jasperserver/services/repository

If you are using the same URL for JasperReports, then keep the URL as is; otherwise, replace it.

e Username
e  Password

4, Click Save.

Jaspersoft iReport Designer retrieves the information from the server. The Repository Navigator appears as follows.
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http://localhost:8080/jasperserver/services/repository

[®1aspersoft iReport Designer 5.1.0

Fle Edit Wiew Format Preview Window Iooks Help

|| Oy ) @ | g [ | =
| Report Inspector |JRepository Navigator A0 X elcome Window x}@ACt\veSubscmptionEyOrg‘]rxml x]@DemoTest‘]rxml x]@Prov\derSubcriptionReport.irxm\ x}
J-?b Z|m Designer AL |Prevlew ||é%@,\9{|'1'fj|umaw5ans s ZAn|b ius====52=2=
5 Jssper Server Repositary T RS SN S URRSSS FRR—. S MR-, SR R———— P—— L] R
B[ Analysis Components 1
B[ Content Files = ¥
B[] Data Sources
B Input data Types
B[ Images
[#-[ | System Properties Fi Access Point Provider Type Resource Pool Subscription Start Date End Date |
B =t
i CSA_Reports |
Inkeractive I |
=
#-[_| Samples £ 1
wf2] ACtiveSubscriptionByOrg |- !
E Q ProviderSubcriptionReport .!
[ Themes
o
o
o
L3

| Report Problems Windove | | iReport output

IReport console Finished [PraviderSuberiptionReport.jrxm] |

€ Compiling to file... C:Ws erstadministratorDesktopulasperRepontDesign siProviderSubcriptionReport jasper
Compilation running time: 749!

B Filling repart...

@ Locale: English (United States)

J Time zone: Default

Report fill running time: 487! (pages generated: 1)

QVIEWIHQ with JasperRepors Viewer
Export running time: 3!

al

Define the Data Source for a Report

You must define the data source for a report. For previewing, the local data source is used, but to display the report from the server,
you must define a data source on the server as well.

1. Select the Data Sources folder in the Repository Navigator pane.
2. Right-click Add > Data Source.

The Data Source dialog box appears.
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Qg
ocH
LI Data Source

General | Data Source Details

Parent Folder [datasources

ID |
Marme |
Descripkion

4] | +]
Save | Cancel I

3. Enter values into the following fields for your data source:
e ID

For example, JRServer.
e Name
For example, SRServerDataSource.
e (Optional) Description
4. Click the Data Source Details tab.

If you select a JDBC data source, you can click the Import from iReport button to help provide these details. Select the local data
source that you specified during report design.
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mnataﬁuurce
Qg

[S]wi
LI

General [Data Source Details

Data Source

Dakasource T':.-'pelJDEC j
~Settings

Diriver Iu:urau:le.jdbc.driver.DracIeDriver

LIRL debc:uracle:thin:@FreshWinOracle: 1521:C54

sername IESEILISEF

Passward I*******

Import From iRepol

Saye Cancel

5. Click Save.

The list of reports in the Repository Navigator pane corresponds to the list that appears on the webpage.
6. Create a folder named CSA_Reports under the Reports folder.
7. Right-click the CSA_Reports folder.
8. Select Add — Report.
9. Enter the name, label, and description for the report.

10. Click Save.

11. Click Browse to browse to and select a .jrxml file (for example, ProviderSubscription. jrxml) and select it.
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This is the JasperReports report template file that was generated when you created the template.

M reportunit wizard Ed

Steps Main JRIXML

1. Maming
2.  Main JRXML
3. Locake Data Source

Locake the main JRXML file

i~ From the repositary

I Erowse |

i+ Locally Defined

I-erRepu:urtDesigns'l,F'r-:u'-.fiu:IerSuI:u:riptiu:unRepu:urt.jrxml

et source From current opened report |

< Back Mextk = Eimist Cancel

12. Click Next.
13. Select a data source from the available data sources.

The following figure uses /datasources/CSA_Reports as an example data source.
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m ReportUnit Wizard

Steps Locakte Data Source

1. Maming
2. Main JRxML
3. Locate Data Source

Locate the Dakta Source

{* From the repository

Janalysis/connections Foodmart

=

Browse

analysisjdatasources (FoodmartDatasource JMODT
[analysisjdatasourcesSugarCRMDataSource
analysisjdatasourcesSugarCRMDataSource JMDT

fdatasources/C5A_Reparts
Idatasources] 15erver JdbeDs
Idatasources) 15erver INDIDS
Idatasources repositoryDa
Idatasources/sugarFoodmartyDs

o

< Back Mexk = | Einish I

Cancel

14. Click Finish.

The report is now available from the website.

providersubcriptionRepart

You can now preview the report.
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M aspersolt iReport Designer 5.5.0

Fle Edt View Formst Preview Window Iooks Hel
(=1 fer = Q| 5
= o feset
Repastory Navigator Rl el x|
» | @@ desgrer | wn [ereven SRS H 4 o0 I DERNQ | «| &

Analysts Cormponents

Subscriptions by Provider

Ji SugarCRM-Foodmart Virtual Data Source Access Point Provider Type Pool Start Date End Date
Tngut data Types )
Yiges T
2 ) Sunnyvale vCenter
Reports https:/localhost:443 VMware vCenter RnD Pool Windows server subs 2013-11-01 08: null
Inkeractive 00:00.0
Samples httpsi/localhost443  VMware vCenter RnD Pool QA Subscription 2013-11-01 08: null
Themes 00:00.0
https:/Nocalhost: 443 VMware vCenter RnD Pool Snow White Program 2013-11-01 08: null
00:00.0

hitp:/itest VMware vCenter  Finance Pool Customer POC #156  2013-11-0108:  nul
00:00.0

Audit Report Examples

This section includes some examples to see specific audit events by running queries on the RPT_AUDIT_EVENT_V database view.

Login events
The following query will return all successful and unsuccessful login attempts in order starting from the most recent:

select * from rpt_audit_event_v where audit_classification = ’Authentication’ order by created_on desc ;

Artifact creation, modification, and deletion

The following query will retrieve the audit event records for a design created with the name “Good Test Design,” which was
subsequently renamed and then deleted:

select created_on, modified_by_username, user_organization_name,artifact_id, artifact_type, artifact_name,
audit_classification, audit_operation,description from rpt_audit_event_v where artifact_id in (select
artifact_id from rpt_audit_event_v where artifact_type='Service Blueprint'and artifact_name='Good Test
Design') order by created_on asc;;

The above query will return a result that is similar to the following example:

created_on modified user_ artifact_id artifact Artifa = audit_ = Audit_ description
_by_ organization = ct_ classif = operatio
usernam _name type name icatio n
e n
02-MAY-14 gooduser CSA-Provider | 297e87c045968b3f | Service Good Create | Create Artifact CUD
02.17.58.258 0145becd045b0lea @ Blueprin | Test Updat Successful
t Design @ e
Delete
02-MAY-14 baduser CSA-Provider | 297e87c045968b3f | Service Bad Create | Update Artifact CUD
02.20.16.597 0145becd045b0lea @ Blueprin | Test Updat Successful
t Design e
Delete
02-MAY-14 baduser CSA-Provider | 297e87c045968b3f | Service Bad Create | Delete Artifact CUD
02.20.46.360 0145becd045b0lea @ Blueprin | Test Updat Successful
t Design e
Delete

Note: Audit event data can be purged if desired by running the DB Purge tool. Refer to the CSA documentation for more information.
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Send documentation feedback

If you have comments about this document, you can send them to clouddocs@hpe.com.

Legal notices

Warranty

The only warranties for Hewlett Packard Enterprise products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. Hewlett Packard
Enterprise shall not be liable for technical or editorial errors or omissions contained herein. The information contained herein is subject
to change without notice.

Restricted rights legend

Confidential computer software. Valid license from Hewlett Packard Enterprise required for possession, use or copying. Consistent with
FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial
Items are licensed to the U.S. Government under vendor’s standard commercial license.

Copyright notice
© Copyright 2017 Hewlett Packard Enterprise Development Company, L.P

Trademark notices

Adobe® is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

UNIX® is a registered trademark of The Open Group.

RED HAT READY™ Logo and RED HAT CERTIFIED PARTNER™ Logo are trademarks of Red Hat, Inc.

The OpenStack word mark and the Square O Design, together or apart, are trademarks or registered trademarks of OpenStack
Foundation in the United States and other countries, and are used with the OpenStack Foundation’s permission.

Documentation updates

The title page of this document contains the following identifying information:
e Software Version number, which indicates the software version.
e Document Release Date, which changes each time the document is updated.
e Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to the following URL and sign-in or
register: https://softwaresupport.hpe.com.

Select Manuals from the Dashboard menu to view all available documentation. Use the search and filter functions to find
documentation, whitepapers, and other information sources.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your Hewlett Packard
Enterprise sales representative for details.

Support

Visit the Hewlett Packard Enterprise Software Support Online web site at https://softwaresupport.hpe.com.
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